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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage 
to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices 
referring only to property damage have no safety alert symbol. These notices shown below are graded according to 
the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance 
are required to ensure that the products operate safely and without any problems. The permissible ambient 
conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may 
be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in this 
publication is reviewed regularly and any necessary corrections are included in subsequent editions.
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Security information 1
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks.
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security 
concept. Siemens’ products and solutions constitute one element of such a concept.
Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. Such systems, machines and components should only be connected to 
an enterprise network or the internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.
For additional information on industrial security measures that may be implemented, please 
visit 
https://www.siemens.com/industrialsecurity. 
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats.
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
under 
https://www.siemens.com/cert. 

Purpose of the manual
This document supports you in performing engineering with the Advanced Process Functions 
(APF) software in the SIMATIC PCS 7 environment.
For information on installing and commissioning, refer to the manual "Advanced Process 
Functions (APF) Installation and Configuration".

Core content
The following core issues are covered in this document:
• How is AS-OS communication configured?
• How is the APF engineering tool operated?
• How are the APF modules configured?

Validity
This documentation is valid for V2.1 of the APF software package.

Advanced Process Functions Engineering Manual
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APF Engineering at a glance 2
Introduction

In this manual, you can find information on the possibilities for configuring with APF (Advanced 
Process Functions).

Configuration steps
APF Engineering involves the following basic steps:
1. Setting up the AS-OS communication

– Setting up the communication on the AS
- Setting up an S7 connection
- Configuring the User Archive Read Manager
- Configuring the User Archive Write Manager

– Setting up the communication on the OS
- Creating tags in WinCC
- Declaring the WinCC tags in the raw data trigger
- Adapting the global script actions

2. General settings in the APF engineering tool
3. Configuring the APF components with the APF engineering tool

– Material management
– Storage location management
– Parameter management
– Archive management

Requirements 
The following requirements must be met for configuring with APF:
• SIMATIC PCS 7 has been installed without errors.
• APF has been installed without errors.
• The master data library must be in the same directory as the multiproject.
• All relevant steps from the PCS 7 Basic Engineering have been performed, and the PCS 7 OS 

has been compiled and downloaded.

Advanced Process Functions Engineering Manual
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• The APF configuration is complete. 
• The APF Integrator has been run after completing the APF configuration.

Note
For information on installing and configuring APF, refer to the manual "Advanced Process 
Functions (APF) Installation and Configuration".
The process pictures may be available in different versions. For example, the material lot 
editor (.pdl picture) available by default as FB_MAT_LOT_ED (recommended for resolution 
1280x1024), is also additionally available as FB_MAT_LOT_ED-1920 optimized for 
1920x1080 resolution and an improved form.
In this manual, the process picture name is used without a suffixed number for both versions.
The inserted screen representations correspond to the PDL pictures with a resolution of 1280 
and generally also apply for the PDL pictures in higher resolution and improved display.

APF Engineering at a glance

Advanced Process Functions Engineering Manual
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Configuring AS-OS communication 3
3.1 Setting up an S7 connection

Introduction
An S7 connection must be set up for data exchange between the AS and OS. An important step 
here is the assignment of the local ID. You need this when assigning the communication block 
parameters on the AS.

Requirement 
• The multiproject configured for APF is open in SIMATIC Manager.

For information on this, refer to the manual "Advanced Process Functions (APF) Installation 
and Configuration".

Procedure
To create an S7 connection, follow these steps:
1. Open the network view (NetPro) in SIMATIC Manager.
2. Select the CPU of the SIMATIC station.

The connection table is displayed in the lower part of the NetPro window.

3. Insert an S7 connection via the shortcut menu.
4. Activate the "Show properties before inserting" check box.

Advanced Process Functions Engineering Manual
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5. Specify a local ID in the "Properties - S7 Connection" dialog.

Note
The local ID is needed for configuring the communication blocks of the User Archive Read 
Manager and User Archive Write Manager.

6. Click "OK".
The connection is created and displayed in the connection table of the NetPro window.

7. If you want to configure a redundant connection to the OS, create a second connection using 
the same procedure.

3.2 User Archive Read Manager
The User Archive Read Manager consists of the "FB_UA_RM" function block and executes the 
following functions:
• Reading one or more data records from the OS user archive to a data block on request
• Transferring read data to the requesting block
• Monitoring communication (generation of alarms)
No picture objects are required for the User Archive Read Manager. Execution of the User Archive 
Read Manager is triggered via the interconnected APF modules.

Configuring AS-OS communication
3.2 User Archive Read Manager
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3.2.1 Function block "FB_UA_RM"
Upon request, the "FB_UA_RM" function block reads data from an OS user archive via the "BRCV" 
communication block (SFB13). It transfers the read data to the requesting block in the AS. 
Communication between the requesting block and the "FB_UA_RM" function block occurs at the 
AS level using the "UDT_UA_R_REQ_ST" (request) and "UDT_UA_R_ST" (feedback) structures.
The "FB_UA_RM" block can manage a maximum of 128 requests. Each request occupies a 
separate structure input (UDT_UA_R_REQ_ST). The requesting block transfers its uniquely 
identifying ID (REQ_ID) to the structure. 
The read data are made available at an output structure (UDT_UA_R_ST) and identified with the 
REQ_ID associated with the job. As a result, the requesting block is able to recognize that the data 
belong to its read request. 
OS tags are used to coordinate the data communication between the AS and OS. Appropriate 
scripts associated with the function block and its functionalities are triggered for operator 
control at the OS level. 

FB_UA_RM

OS

3.2.2 Configuring the "FB_UA_RM" function block
To configure the "FB_UA_RM" function block, follow these steps:
1. Create a new hierarchy folder in the PH.
2. Create a new CFC in the hierarchy folder, and open it in the CFC Editor.

Configuring AS-OS communication
3.2 User Archive Read Manager
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3. Insert the "FB_UA_RM" function block from the master data library into the CFC.
Note
An "FB_UA_RM" block should run in a faster OB than the requesting blocks.

4. Rename the function block "UA_RM".
Note
The name "UA_RM" is specified by the APF system and must not be changed here or in 
subsequent configuring steps. If you want to use several "FB_UA_RM" function blocks, you 
must configure them in different CFCs.

Configuring AS-OS communication
3.2 User Archive Read Manager
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5. Configure the inputs and outputs of the function block.
– For the "ID_1" input, enter the value of the local ID you specified for the configured S7 

connection.
– Enter a unique value for the "R_ID_1" input, and keep track of it. You need this value when 

configuring the OS tags.
– At the "ID" input, specify a unique ID for the block. Recommendation: "ID" = "R_ID_1".

– Configure the other input and output parameters of the function block.

Note
You can find a detailed description of the input and output parameters in the block 
description of the "FB_UA_RM" function block.

Configuring AS-OS communication
3.2 User Archive Read Manager
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6. Compile the CFCs and download them to the AS.
7. Compile the OS.

Note
if you subsequently change the values for ID_1 / ID_2, you must perform one of the following 
procedures:
• Perform a complete restart of the CPU (preferred)
• Re-instantiate the affected "FB_UA_RM" blocks in the CFC (= new data block), that means 

rewire from the old instances, delete the old ones, rename the new ones, then perform 
an AS delta compile and download and an OS delta compile and download. 

Therefore, the definition of ID_1 and ID_2 should be well thought out.

3.3 User Archive Write Manager
The User Archive Write Manager consists of the "FB_UA_WM" function block and executes the 
following functions:
• Writing one or more data records from an AS data block to an OS user archive on request.
• Monitoring communication (generation of alarms)
No picture objects are required for the User Archive Write Manager. Execution of the User Archive 
Write Manager is triggered via the interconnected APF modules.

Note
An RM/WM module should run in a OB faster than the requesting blocks.

3.3.1 Function block "FB_UA_WM"
Upon request, the "FB_UA_WM" function block writes data to an OS user archive via the "BSEND" 
communication block (SFB12). 
The data to be written are copied from a requesting block. Communication between the 
requesting block and the "FB_UA_WM" function block occurs at the AS level using the 
"UDT_UA_W_REQ_ST" (request) and "UDT_UA_W_ST" (feedback) structures.
The "FB_UA_WM" function block can manage a maximum of 128 requests. Each request 
occupies a separate structure input (UDT_UA_W_REQ_ST) in the block. The requesting block 
transfers its uniquely identifying ID (REQ_ID) to the structure. 
The feedback in response to a write request is stored in a structure output (UDT_UA_W_ST) and 
identified with the REQ_ID associated with the job. As a result, the requesting block is able to 
detect that the feedback data belong to its write request. 
OS tags are used to coordinate the data communication between the AS and OS. Appropriate 
scripts associated with the "FB_UA_WM" function block and its functionalities are triggered for 
operator control at the OS level.

Configuring AS-OS communication
3.3 User Archive Write Manager
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FB_UA_WM

OS

3.3.2 Configuring the "FB_UA_WM" function block
To configure the "FB_UA_WM" function block, follow these steps:
1. Create a new hierarchy folder in the PH.
2. Create a new CFC in the hierarchy folder, and open it in the CFC Editor.
3. Insert the "FB_UA_WM" function block from the master data library into the CFC.

Note
An "FB_UA_WM" block OB should run in a faster OB than the requesting blocks.

4. Rename the function block "UA_WM".
Note
The name "UA_WM" is specified by the APF system and must not be changed here or in 
subsequent configuring steps. If you want to use several "FB_UA_WM" function blocks, you 
must configure them in different CFCs.

Configuring AS-OS communication
3.3 User Archive Write Manager

Advanced Process Functions Engineering Manual
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5. Configure the inputs and outputs of the function block.
– For the "ID_1" input, enter the value of the local ID you specified for the configured S7 

connection.
– Enter a unique value for the "R_ID_1" input, and keep track of it. You need this value when 

configuring the OS tags in a later configuring step.
– At the "ID" input, specify a unique ID for the block. Recommendation: "ID" = "R_ID_1".

– Configure the other input and output parameters of the function block.

Note
You can find a detailed description of the input and output parameters in the block 
description of "FB_UA_WM".

Configuring AS-OS communication
3.3 User Archive Write Manager
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6. Compile the CFCs and download them to the AS.
7. Compile the OS.

Note
if you subsequently change the values for ID_1 / ID_2, you must perform one of the following 
procedures:
• Perform a complete restart of the CPU (preferred)
• Re-instantiate the affected "FB_UA_WM" blocks in the CFC (= new data block), that means 

rewire from the old instances, delete the old ones, rename the new ones, then perform 
an AS delta compile and download and an OS delta compile and download. 

Therefore, the definition of ID_1 and ID_2 should be well thought out.

3.4 Creating raw data tags in WinCC

Introduction
Tags are created in the WinCC Tag Management to configure a connection to the communication 
blocks of the User Archive Read Manager (FB_UA_RM) and the User Archive Write Manager 
(FB_UA_WM). 
Each configured "FB_UA_RM" and "FB_UA_WM" block requires one tag. 

Requirement 
• WinCC Explorer is open.

User Archive Read Manager
To create the tags for data exchange with the "FB_UA_RM" block, follow these steps:
1. Open the configured communication connection in the WinCC Explorer Tag Management 

(you can find it with the S7 program name under "Named Connections"). See section Setting 
up an S7 connection (Page 11).

2. Enter a new tag at the end of the tag list.
3. Enter the tag name according to the following pattern:

– Name of CFC/UA_RM_DATA
The "Name of CFC" prefix refers to the name of the CFC in which the "FB_UA_RM" function 
block is configured and to which a connection must be established. 
The name "UA_RM_DATA" is specified by the APF system and must also not be changed here 
or in subsequent configuring steps.
Example: 
If the CFC is called "FB_UA_RM", the tag name is: FB_UA_RM/UA_RM_DATA.

4. In the "data type" column, select the entry "raw data type".
5. Click the "...." button in the "Address" column. The "Address Properties" dialog opens.

Configuring AS-OS communication
3.4 Creating raw data tags in WinCC
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6. Select the "Raw data" check box.
7. In the "R_ID" field, enter the value that you have configured for the "R_ID1" input parameter 

of the associated "FB_UA_RM" function block.

8. Select the "BSEND/BRCV" option.
9. Close the dialog box by clicking "OK". 

User Archive Write Manager
To create the tags for data exchange with the "FB_UA_WM" block, follow these steps:
1. Open the configured communication connection in the WinCC Explorer Tag Management 

(you can find it with the S7 program name under "Named Connections"). See section Setting 
up an S7 connection (Page 11).

2. Enter a new tag at the end of the tag list.
3. Enter the tag name according to the following pattern:

– Name of CFC/UA_WM_DATA
The "Name of CFC" prefix refers to the name of the CFC in which the "FB_UA_WM" function 
block is configured and to which a connection must be established. 
The name "UA_WM_DATA" is specified by the APF system and must also not be changed here 
or in subsequent configuring steps.
Example:
If the CFC is called "FB_UA_WM", the tag name is: FB_UA_WM/UA_WM_DATA.

4. In the "data type" column, select the entry "raw data type".
5. Click the "...." button in the "Address" column. The "Address Properties" dialog opens.
6. Select the "Raw data" check box.

Configuring AS-OS communication
3.4 Creating raw data tags in WinCC
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7. In the "R_ID" field, enter the value that you have configured for the "R_ID1" input parameter 
of the associated "FB_UA_WM" function block.

8. Select the "BSEND/BRCV" option.
9. Close the dialog box by clicking "OK". 

3.5 Registering WinCC tags in the WinCC Data Manager

Introduction
All tags that are configured in WinCC for data exchange between the "FB_UA_RM" and 
"FB_UA_WM" blocks and the OS must be registered in the WinCC Data Manager. For this, the tags 
must be entered as a trigger in the "FB_RawDataTrigger.pas" action.

Requirement
• WinCC Explorer is open.

Procedure
To enter a tag as a trigger, follow these steps:
1. Open the "FB_RawDataTrigger.pas" action in the Global Script Editor.
2. Click the  button in the toolbar.

The "Properties" dialog box opens.
3. Open the "Trigger" tab.

Configuring AS-OS communication
3.5 Registering WinCC tags in the WinCC Data Manager
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4. Select the "Tag" entry and click the "Add" button.

The "Add trigger" dialog box opens.
5. Use the  button in the "Tag name" area to insert the tags that you configured for the 

"FB_UA_RM" and "FB_UA_WM" blocks. See section Creating raw data tags in WinCC (Page 19).
6. Click "OK". 

Example
In the following example, the multiproject contains one "FB_UA_RM" block and one 
"FB_UA_WM" block. The blocks are configured in CFCs of the same name. The associated WinCC 
tags are entered as triggers:

3.6 Adapting WinCC actions

Introduction
Scripts are triggered using WinCC actions for data exchange between the AS and OS. Based on 
an APF template, one C-action must be created for each configured "FB_UA_RM" and 
"FB_UA_WM" function block.

Requirement
• WinCC Explorer is open.

Configuring AS-OS communication
3.6 Adapting WinCC actions
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User Archive Read Manager
To adapt the C-action for the User Archive Read Manager, follow these steps:
1. Open the "FB_ReadRecordTrigger0.pas" template file in the Global Script Editor and save it 

under a different name, e.g., "FB_ReadRecordTrigger1.pas".
2. Insert a new trigger tag.

Configuring AS-OS communication
3.6 Adapting WinCC actions

Advanced Process Functions Engineering Manual
System Manual, 06/2022, A5E38719921-AB 23



3. Enter a value in the "Tag name" field according to the following pattern:
– Name_CFC_chart/UA_RM.OS_TRIG
The "Name_CFC_chart" prefix refers to the CFC in which the "FB_UA_RM" function block is 
configured as a communication partner.
See Function block "FB_UA_RM" (Page 13) for more information.
The name "/UA_RM.OS_TRIG" is specified by the APF system and must also not be changed 
here or in subsequent configuring steps. 
Note
If naming is set up for the folders of the plant hierarchy, the hierarchy path must also be 
entered:
• Names of folders in hierarchy path/Name_CFC_chart/UA_RM.OS_TRIG

4. Adapt the update of the standard cycle. 
5. Click "OK" to add the trigger tag.

Configuring AS-OS communication
3.6 Adapting WinCC actions

Advanced Process Functions Engineering Manual
24 System Manual, 06/2022, A5E38719921-AB



6. Adapt the action script accordingly for the created trigger tag.

7. Save and close the action.

Configuring AS-OS communication
3.6 Adapting WinCC actions
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Example
In the following example, the "FB_UA_RM" block is located in the CFC named "FB_UA_RM". The 
block name in the CFC is always the same (UA_RM). The name of the trigger tag consists of the 
CFC name "FB_UA_RM" plus the suffix "/UA_RM.OS_TRIG" (FB_UA_RM/UA_RM.OS_TRIG).

User Archive Write Manager
To adapt the C-action for the User Archive Write Manager, follow these steps:
1. Open the "FB_WriteRecordTrigger0.pas" template file in the Global Script Editor and save it 

under a different name, e.g., "FB_WriteRecordTrigger1.pas".
2. Insert a new trigger tag.

Configuring AS-OS communication
3.6 Adapting WinCC actions
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3. Enter a value in the "Tag name" field according to the following pattern:
– Name_CFC_chart/UA_WM.OS_TRIG
The "Name_CFC_chart" prefix refers to the CFC in which the "FB_UA_WM" function block is 
configured as a communication partner.
See Function block "FB_UA_WM" (Page 16) for more information.
The name "/UA_WM.OS_TRIG" is specified by the APF system and must also not be changed 
here or in subsequent configuring steps. 
Note
If the naming is set up for the folders of the plant hierarchy, the hierarchy path must also be 
entered:
• Names of folders in hierarchy path/Name_CFC_chart/UA_WM.OS_TRIG

4. Adapt the update of the standard cycle. 
5. Click "OK" to add the trigger tag.

Configuring AS-OS communication
3.6 Adapting WinCC actions
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6. Adapt the action script accordingly for the created trigger tag.

7. Save and close the action.

Example
In the following example, the "FB_UA_WM" block is located in the CFC named "FB_UA_WM". The 
block name in the CFC is always the same (UA_WM). The name of the trigger tags consists of the 
CFC 
chart name "FB_UA_WM" plus the suffix "/UA_WM.OS_TRIG" (FB_UA_WM/UA_WM.OS_TRIG).

Configuring AS-OS communication
3.6 Adapting WinCC actions
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3.7 Checking redundancy tag in WinCC

Introduction
To run two OS servers in a redundant configuration, an internal WinCC tag (Redundancy_active) 
that is created automatically by the engineering tool is used. This tag is also required in non-
redundant systems. The description below is only for checking the tag.

Requirement
• WinCC Explorer is open.

Configuring AS-OS communication
3.7 Checking redundancy tag in WinCC
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Procedure
Check the internal WinCC tag (internal tags) "Redundancy_active" to ensure they are present and 
have the correct start value.

Note
Start value:
• Redundancy_active = 0 → Redundancy not active
• Redundancy_active = 1 → Redundancy active

Configuring AS-OS communication
3.7 Checking redundancy tag in WinCC
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APF Engineering Tool 4
4.1 Introduction

With the help of the APF engineering tool, you can configure the following APF modules:
• Material management
• Storage location management
• Parameter management
• Archive management
You specify the data for the individual APF modules on a project-specific basis in the engineering 
tool and generate user archives in which the data are saved. To enable access from the AS to the 
user archives, you generate AS function blocks based on the data contained in the APF 
engineering tool and interconnect these function blocks with the function blocks of the User 
Archive Read Manager and User Archive Write Manager (FB_UA_RM and FB_UA_WM). Upon 
request, the data are written to or read from the user archives. 
During process control, you use pre-configured picture objects (process pictures and faceplates) 
that are contained in the APF software package to perform operator control and monitoring of 
the data configured using the APF engineering tool.
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Note
Following configuration with the APF engineering tool or in the case of configuration changes, 
the APF Integrator must be run. For more information, refer to the section "Running the APF 
Integrator (Page 103)".

4.2 Opening the APF engineering tool

Introduction
Following successful APF installation, the APF engineering tool is available in WinCC Explorer 
under the entry "APF engineering tools" and can be run from there.

Requirement
• WinCC Explorer is open.

APF Engineering Tool
4.2 Opening the APF engineering tool
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Procedure
To open the APF engineering tool, follow these steps:
1. Click the "APF engineering tools" entry in the navigation area of WinCC Explorer.

The APF applications are displayed on the right in WinCC Explorer.

2. Double-click the "APF engineering tool" application.
The APF engineering tool opens.

APF Engineering Tool
4.2 Opening the APF engineering tool
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4.3 Layout of the user interface
The following figure shows the layout of the user interface of the APF engineering tool:

① Menu bar:
You can find all the commands needed to operate the APF engineering tool in the menu bar.

② Toolbar:
The toolbar provides you with buttons for frequently used commands.

③ Navigation area:
The navigation area gives you access to the individual APF modules and their data.

④ Workspace:
The objects that you open for editing purposes are displayed within the working area. The working area has a table 
structure. Each data record occupies one row. 

⑤ Status bar:
General project information is displayed in this area. 

Menu bar
• "File" menu

The following table shows the commands that are grouped in the "File" menu:

Command Explanation
Settings This command opens the "Settings" dialog where 

you can make general project settings as well as 
specific settings for the APF modules.

Print Preview Displays a print preview of the current working area

APF Engineering Tool
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Command Explanation
Print Prints the current working area
Printer Setup Opens a dialog where you set up the printer
Close Closes the APF engineering tool

• "Edit" menu
The following table shows the commands that are grouped in the "Edit" menu:

Command Explanation
Undo Undoes the last action
Cut Cuts a data record
Copy Copies a data record
Paste Pastes a copied data record
New Inserts a new data record
Delete Deletes a data record
Delete row Deletes a row in the working area

• "View" menu
The following table shows the commands that are grouped in the "View" menu:

Command Explanation
Toolbars and docking windows Displays and hides the toolbars and docking win‐

dows in the user interface
Status Bar Displays and hides the status bar

• "Help" menu
The following table shows the commands that are grouped in the "Help" menu:

Command Explanation
Keyboard assignment You can use this command to specify the keyboard 

operation.
Info about APF engineering tool .. You can use this menu to access information about 

the installed version of the APF engineering tool.

Toolbar
The following table shows the commands that are displayed in the toolbar in its default setting:

Icon/Button Explanation
Cuts a data record
Copies a data record
Pastes a copied data record
Prints the current working area
Displays a print preview of the current working area
Opens the "Settings" dialog
Zooms the view of the working area in/out

APF Engineering Tool
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Icon/Button Explanation
Calls information about the installed version of the 
APF engineering tool
You can use this button to customize the display of 
buttons in the toolbar.

Reset Textlib IDs
The "Reset Textlib IDs" button, which is available in some dialogs, has the following effect:
• The Textlib ID of the current view is deleted.
• After saving, new entries are created in the text library.
• These then need to be filled with text using WinCC resources.
This function supports the import of a text library from another project, if the IDs overlap.

4.4 "Settings" dialog
The "Settings" dialog is opened via the "File" menu or the  toolbar button. Available settings 
there include:
• Display of user archives of the individual APF modules
• Setting the numbering of APF message texts in Alarm Logging
• Setting the date and time format

APF Engineering Tool
4.4 "Settings" dialog
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"General" tab
You can make general project settings in the "General" tab.

The "General" tab consists of the following areas:

Area Explanation
First Alarm Logging ID First message number for module-independent 

APF messages (Messages_General_de.txt) 
See the "Advanced Process Functions (APF) Instal‐
lation and Configuration" document.

Server prefix Symbolic name of OS server project with the suffix 
"::". (Example: "OSServerProject::")

Redundancy is active Yes/No check box
Date and time format of header fields Format in which the time and date are displayed.
Language Language of the APF engineering tool (cannot be 

set; derived from WinCC Explorer language setting)
Backup directory 1 First backup directory path for APF user archive da‐

ta backups
Backup directory 2 Second backup directory path for APF user archive 

data backups (optional)
SIMATIC BATCH If used, set the check mark and select the PCell

APF Engineering Tool
4.4 "Settings" dialog
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"Material management" tab
In the "Material management" tab, you can find information and settings for the "Material 
management" APF module.

APF Engineering Tool
4.4 "Settings" dialog
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The "Material management" tab consists of the following areas:
• Archive names

This area shows the pre-assigned user archives in which the material management data are 
saved. 

Area User archive Explanation
Class archive FB_MATCLASS Definition of the material classes
Type archive FB_MATTYPE Definition of the material types
Material attribute archive FB_MATATTRIB Definition of the material attributes
Material archive FB_MATERIAL Archiving of the materials and their values 

for the attributes
Material lot archive FB_MATERIAL_LOT Archiving of the material lots
Material lot attribute archive FB_MATLOTATTRIB Definition of the material lot attributes 
Material status archive FB_MAT_STATUS Definition of the material status texts

The names of the user archives are pre-assigned and cannot be edited.
• Display of each first alarm logging ID for

– Material messages
– Material error messages
– Material lot messages
– Material lot error messages

Note
For information on importing APF messages in Alarm Logging, refer to "Advanced Process 
Functions (APF) Installation and Configuration".

• Assign IDs automatically
You can use these check boxes to specify whether the IDs for materials or material lots are 
assigned manually or automatically when new data records are created. 

APF Engineering Tool
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"Storage management" tab
In the "Storage management" tab, you can find information and settings for the "Storage 
management" APF module.

APF Engineering Tool
4.4 "Settings" dialog
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The "Storage management" tab consists of the following areas:
• Archive names

This area shows the pre-assigned user archives in which the storage management data are 
saved.

Area User archive Explanation
Group archive FB_STORGROUP Definition of the storage location groups
Actual value archive FB_STORVALUE Definition of the actual storage location 

values 
Attribute archive FB_STORATTRIB Definition of the storage location param‐

eters 
Storage location archive FB_STORAGE Archiving of the storage locations 
Storage location status ar‐
chive

FB_STOR_ST_STATUS Definition of storage location status texts

Procedure archive FB_PROCEDURES Definition of the procedure releases 
The names of the user archives are pre-assigned and cannot be edited.

• Display of each first alarm logging ID for
– Storage location messages
– Error messages

Note
For information on importing APF messages in Alarm Logging, refer to "Advanced Process 
Functions (APF) Installation and Configuration".

• Assign IDs automatically
You can use this check box to specify whether the IDs for storage locations are assigned 
manually or automatically when new storage location data records are created. 

• Material class releases
In this area you can see the quantity (0-4) of material class releases. 

• Material type releases
In this area you can see the number of material type releases.

• Monitoring time
In this field you can enter the monitoring time in increments of 2 seconds. The monitoring 
time is started in the process picture via the “Actual values” button. If positive feedback from 
all affected "FB_SACT" blocks does not arrive within this monitoring time, the user is notified 
that not all displayed storage locations could be updated.

• Tags
In this area you can enter the tags of the "FB_SACT" blocks for each automation system.

APF Engineering Tool
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"Parameter management" tab
In the "Parameter management" tab, you can find information and settings for the "Parameter 
management" APF module.

APF Engineering Tool
4.4 "Settings" dialog
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The "Parameter management" tab consists of the following areas:
• Archive names

This area shows the pre-assigned user archives in which the parameter management data are 
saved.

Area User archive Explanation
Group archive FB_PARAMGROUP Definition of the parameter groups
Attribute archive FB_PARAMATTRIB Definition of the parameters and their 

properties (attributes)
Parameter archive FB_PARAM Archiving of the parameter sets and their 

values 
Calculation archive FB_PARAM_CALC Buffering of newly calculated parameter 

sets
The names of the user archives are pre-assigned and cannot be edited.

• Display of each first alarm logging ID for
– Parameter messages
– Parameter errors
– Limit messages
– Limit errors
– Job messages
– Job errors

Note
For information on importing APF messages in Alarm Logging, refer to "Advanced Process 
Functions (APF) Installation and Configuration".

• Assign IDs automatically
You can use this check box to specify whether the IDs for parameter sets are assigned 
manually or automatically when new parameter data records are created. 

APF Engineering Tool
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"Archive management" tab
In the "Archive management" tab, you can find information and settings for the "Archive 
management" APF module.

The "Archive management" tab consists of the following areas:
• Archive names

This area shows the pre-assigned user archives in which the archive management data are 
saved.

Area User archive Explanation
Group archive FB_ARCHGROUP Definition of the archive groups
Value archive FB_ARCHVALUE Definition of the archive values
Archiving archive FB_ARCHIVING Archiving of the archive data records 

The names of the user archives are pre-assigned and cannot be edited.
• Display of each first alarm logging ID for

– Archiving messages
– Error messages

Note
For information on importing APF messages in Alarm Logging, refer to "Advanced Process 
Functions (APF) Installation and Configuration".

• Use MES
You can use this check box to specify whether an MES is used.

APF Engineering Tool
4.4 "Settings" dialog
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4.5 Data formats

Enumerations
All modules that access user archives can operate with the S7 data type "enumeration". 
Enumerations must be created in SIMATIC Manager for this. You do this in the project folder 
under "Global declarations". For details on configuring and working with multilingual 
enumerations, refer to the SIMATIC Manager help. It is important to note that enumeration 
values cannot contain more than 15 characters. Unlike in SIMATIC Manager, 16-character values 
are not permitted.
If an enumeration has been generated in SIMATIC Manager, you must ensure when creating a 
user archive that the name of the enumeration is entered in the "ENUM_MAT" column for that 
archive. The available enumerations are provided in a selection list.
You can also find the name of the enumeration in the "Object name" column of the 
"Enumerations" folder in SIMATIC Manager. A maximum of 87 values can be displayed in the OS 
when all 1 – 87 numbers are used (no spaces). If numbers with multiple digits are used, the 
number of possible values is reduced accordingly. 
For example, if the enumeration numbers are always 3-digit, a maximum of 64 values can be 
used.

Note
Never use the value "0" for enumerations.

Materials
With certain modules such as those for material lot management and parameter management, 
you can create individual parameters/attributes of the "Material" type.
This enables you to select a specific material from those listed in a pull-down menu. You can only 
use this function if the material master data management function already exists in the project 
or has been configured with the engineering tool. The class and type for the "Material" attribute 
must be specified. This is done in the engineering tool when you create the relevant "Material" 
attribute.
The class and type of the material must be entered in the "Enum_Mat" column. The first three 
digits represent the material class and the second three specify the material type. For example, 
003002 corresponds to material class 3 and material type 2. The leading zeros must always be 
included, which means the figure must always have six digits.
The available combinations of material class and type can be accessed from a selection list.
Enum_Mat = XXX000 displays all materials of class XXX regardless of type.

APF Engineering Tool
4.5 Data formats

Advanced Process Functions Engineering Manual
System Manual, 06/2022, A5E38719921-AB 45



Date format
In S7, only the years 1990 to 2089 are specified in the "DATE_AND_TIME" data type because the 
year is represented by two digits only. All inputs and outputs of a block that are to represent date/
time are based on the S7 "DATE_AND_TIME" data type. It consists of two double words that are 
used separately as two inputs/outputs in the blocks of the APF Toolbox; the same name is 
assigned to both but the name of the second double word ends in "B" (e.g., DATE1 and DATE1B). 
To convert to the "DATE_AND_TIME" data type, the two double words can be used together in 
direct sequence.
The two double words are structured as follows:

Double word Bytes Explanation
1 0 Year
1 1 Month
1 2 Day
1 3 Hour
2 4 Minute
2 5 Second
2 6 The two most significant digits for milliseconds
2 7 (4 MSB) The least significant digit for milliseconds
2 7 (4LSB) Day of the week (1=Sunday, 2 = Monday, etc.)

MSB = 4 most significant bits
LSB = 4 least significant bits
Refer to the PCS 7 Help on the "DATE_AND_TIME" data type for more detailed information.

4.6 Block versioning

Objective
The sections below describe how the engineering tool, depending on the defined parameters 
and attributes
• Generates function blocks with corresponding inputs/outputs.
• Generates the user archive with corresponding column names.
This means there may be inconsistencies when changing parameters and attributes if the 
workflow is not followed correctly. In order to prevent this, the APFs include the version-
checking mechanisms described below.

APF Engineering Tool
4.6 Block versioning
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Block version
On generating a block, the Engineering Tool issues a "Generation version" (starting with 1) and 
writes it in the block (input/output GEN_AS) and additionally in the  file FB_Numbers.ini. 
When making changes using the Engineering Tool (e.g. changes to attributes) and regenerating 
the block, the number of the generation version will increase. The file thus includes the current 
generation version for all of the generated blocks. When downloading, the file FP_Numbers.ini 
is transferred to the OS.

Checking by Read / Writemanager FB_UA_RM / FB_UA_WM
If a block transmits a block to FB_UA_RM / FB_UA_WM, it also writes its generation version 
(GEN_AS) in the telegram.
The scripts called by FB_UA_RM / FB_UA_WM read the target generation version from the 
FB_Numbers.ini file and compare it with the generation version from the read/write 
requirement.
If the versions are not the same, the read-write jobs will not be executed. FB_UA_RM / 
FB_UA_WM returns the target generation version to the requesting block.

Check at the requesting block
Using the function FB_CHECK , the requesting block compares its own version GEN_AS with 
the returned version. In the case of an error, the error output QERR_VER is set and a message is 
generated.
The block itself is not blocked.
The error output will be reset if a request is able to be successfully executed. The output 
QRELEASED of the requesting bloick is statically set to TRUE and will be switched invisibly for the 
CFC. The output QGR_ERR contains QERR_VER, but for reasons of compatibility only one 
extended edge will be linked in by QERR_VER .

Note
This change in behavior of the blocks compared to previous APF versions may have 
repurcussions on wired user blocks to QRELEASED and QERR_VER.

APF Engineering Tool
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Material management 5
5.1 Overview

The "Material management" APF module is used to implement automation tasks such as the 
following:
• Material master data management
• Material lot data management

User archives
You can find information on the material management user archives in the "Material 
management" tab of the "Settings" dialog.

Process pictures
During process control, you use the following picture objects (process pictures and faceplates) 
to perform operator control and monitoring of the data configured using the APF engineering 
tool:

Picture objects Explanation
FB_MAT_ED.PDL Picture for operator control and monitoring of the ma‐

terial master data
@FB_MAT_ED_WINDOW.PDL Faceplate for operator control and monitoring of mate‐

rial attributes
FB_MAT_LOT_ED.PDL Picture for operator control and monitoring of the ma‐

terial lot data
@FB_MAT_LOT_ED_WINDOW.PDL Faceplate for operator control and monitoring of the 

free parameters of the data records

Note
You can find information on the transfer of APF pictures to the PH in the section "Transferring APF 
process pictures to the plant hierarchy (Page 104)".
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AS function blocks
To generate the function blocks for the material management, the following blocks are used as 
templates.

Function block (FB) Number Function
FB_XXXMA FB1777 • Provision of the material master data in the user ar‐

chive via the User Archive Read Manager in the AS
• Transfer of the material master data in the AS to the 

user archive via the User Archive Write Manager
FB_MLOT FB1778 • Provision of the material lot data in the user archive 

via the User Archive Read Manager in the AS
• Transfer of the material lot data in the AS to the user 

archive via the User Archive Write Manager

5.2 Material classes
You can use the APF engineering tool to define material classes and generate a function block of 
type "FB_XXXMA" for each material class. The material classes are saved in the "FB_MATCLASS" 
user archive.
The material classes are displayed in a selection list in the process picture.

Material management
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5.2.1 Creating and editing material classes

Creating material classes
To create a material class, follow these steps:
1. Open the material management in the navigation area of the APF engineering tool.
2. Select the "Material classes" group.
3. Select the "New" command in the shortcut menu.

The "Add material class" dialog opens.
4. Enter a name for the material class and click the "OK" button.

The material class is created with default properties and displayed in the navigation area. 

Editing material classes
In the working area of the APF engineering tool, you can edit the following properties of the 
material classes:

Area Explanation
Name Name of material class
Textlib ID ID for multilingual management in the text library (non-editable; as‐

signed automatically)
FB number Number of the function block that is generated for the material class.

Block numbers FB1775-1795 are reserved for APF blocks and must not 
be overwritten.

Material management
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To edit the properties of a material class, follow these steps:
1. Select the required material class in the navigation area.

The properties of the selected material class are displayed in the working area.
2. Define the properties of the material class in the working area of the engineering tool.

3. Click the "Save" button to save the changes.
4. Click the "Dismiss" button to discard the changes.

Deleting material classes
Deletion is not possible, in order to guarantee data consistency.

5.2.2 Creating and editing attributes
You can define up to 100 attributes (material properties) for each material class. An output is 
created for each attribute when the "FB_XXXMA" function block is generated. The attribute data 
are saved in the "FB_MATTATTRIB_XXX" user archives.
The attributes are displayed and can be assigned with values in the process picture.

Material management
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Adding new attributes to a material class
To add an attribute to a material class, follow these steps:
1. Select the required material class in the navigation area of the APF engineering tool.

All attributes of the selected material class are displayed in the working area.

2. Click in the last row of the working area and specify the following properties:

Column Explanation
Pos Position in the visualization order. 
Name Name of the attribute
UoM Unit of the attribute
Format Format of the attribute
Enum_Mat Name/coding of an enumeration

The "ENUM_MAT" field can only be selected if you have set "ENU‐
MERATION" as the format of the attribute. You can create enumera‐
tions in SIMATIC Manager under "Global Declarations".

Low limit Lower operator control limit for numerical values
High limit Upper operator control limit for numerical values
TXTLIB ID for multilingual management in the text library (non-editable; 

assigned automatically)
FCT_ IO_BLOCK_NAME Name of the output in the AS block
Visible You can use the "Visible" check box to specify whether the attribute 

is displayed in the process picture.

3. Click the "Save" button.

Editing attributes
To change the properties of the attributes, follow the steps below:
1. Select the required material class in the navigation area of the APF engineering tool.

All attributes of the selected material class are displayed in the working area.
2. Click in the row of the attribute to be edited and make the required changes.

Material management
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3. Click the "Save" button to save the changes.
4. Click the "Dismiss" button to discard the changes.

Deleting attributes
To delete an attribute, follow these steps:
1. Select the row of the attribute.
2. Select the "Delete row" command in the "Edit" menu.
The attribute is removed from the working area. 

5.3 Material types
You can assign up to ten material types to each material class. The material types are saved in the 
"FB_MATTYPE_XXX" user archives.
The material types are displayed in a selection list in the process picture.

Material management
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Creating material types
To create a material type, follow these steps:
1. Open the material management in the navigation area of the APF engineering tool.
2. Select the "Material types" group.

All defined material types are displayed in the working area.

3. Click in the last row of the table in the working area and specify the following properties:

Column Explanation
Name Name of the material type
TXTLIB ID for multilingual management in the text library (non-editable; assigned 

automatically)

4. Click the "Save" button.
The material type is created.

Editing material types
To edit the properties of a material type, follow these steps:
1. Select the "Material types" group in the navigation area of the APF engineering tool.

All defined material types are displayed in a table in the working area.
2. Click in the row of the material type to be edited and make the required changes.
3. Click the "Save" button to save the changes.
4. Click the "Dismiss" button to discard the changes.

Deleting material types
Deletion is not possible, in order to guarantee data consistency.

Material management
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5.4 Materials
You create the materials in Runtime using the "FB_MAT_ED.PDL" process picture. Each material 
is assigned to a material class and a material type and defined by the values that are specified for 
the individual attributes of the material class. The created materials are saved in the 
"FB_MATERIAL_XXX" user archives.

5.5 Material triggers
You can configure triggers for data backup operations. These start the backup of user archive 
data at defined intervals. 
The following triggers are used for backing up the configuration data of the material 
management.

Trigger Function
FB_MMBackupTriggerEN.pas Triggers backup of the configured material master 

data
FB_MLBackupTriggerEN.pas Triggers backup of the configured material lot mas‐

ter data
FB_MAT_STATUS_BackupTriggerEN.pas Triggers backup of the material lot status texts

The following triggers are used for creating a backup of the Runtime data of the material 
management.

Trigger Function
FB_MMBackupTriggerRTx.pas Triggers backup of the data of a material class that 

are written to the user archives during runtime. 
For each material class, a trigger is created and 
numbered consecutively.

FB_MLBackupTriggerRTx.pas Triggers backup of the material lot data that are 
written to the user archives during runtime. 

Material management
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 Configuring a trigger
To configure a trigger with the APF engineering tool, follow these steps:
1. Select the "Material trigger" group in the navigation area of the APF engineering tool.

The triggers are displayed in the working area.

2. Click the "Edit" button in the row of the required trigger.
The "Edit trigger" dialog opens.

3. Configure the following properties of the trigger:

Area/check box Explanation
Name Name of the trigger (non-editable)
Cycle Intervals for executing the actions in runtime:

Standard cycle
Hourly
Daily
Weekly
Monthly
Annually

Enabled Activation of the trigger
Cycle time Timing of the execution (depending on the cycle set‐

ting)

Material management
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4. Click "OK".
5. The "Edit trigger" dialog closes.
6. Click the "Save" button in the working area of the APF engineering tool to apply the changes.
7. Click the "Dismiss" button in the working area of the APF engineering tool to discard the 

changes.

5.6 Material lots
You create and edit the material lots in Runtime using the "FB_MAT_LOT_ED.PDL" process 
picture. Each material lot is assigned to a material class, a material type, and a material. The 
created material lots are saved in the "FB_MATERIAL_LOT" user archive.

You can use the APF engineering tool to define up to 100 material lot attributes and generate a 
function block of type "FB_MLOT". An output is created for each attribute when the function 
block is generated. The attribute data are saved in the "FB_MATTATTRIB_LOT" user archive.
The material lot attributes can be displayed and assigned with values in the process picture.

Material management
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Adding attributes
To add an attribute, follow these steps:
1. Select the "Material lots" group in the navigation area of the APF engineering tool.

All defined attributes are displayed in the working area.

2. Specify the number of the function block that is generated for the material lot management.
Note
Block numbers FB1775-1795 are reserved for APF blocks and must not be overwritten.

3. Click on the last row in the working area and specify the following properties:

Column Explanation
Pos Position in the visualization order
Name Name of the attribute
UoM Unit of the attribute
Format Format of the attribute
Enum_Mat Name/coding of an enumeration

The "ENUM_MAT" field can only be selected if you have set "ENU‐
MERATION" as the format of the attribute. You can create enumera‐
tions in SIMATIC Manager under "Global Declarations".

Low limit Lower operator control limit for numerical values
High limit Upper operator control limit for numerical values
TXTLIB ID for multilingual management in the text library (non-editable; 

assigned automatically)
FCT_IO_BLOCK_NAME Name of the output in the AS function block
Visible You can use the "Visible" check box to specify whether the attribute 

is displayed in the process picture.

4. Click the "Save" button.

Material management
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Editing attributes
To edit the attributes, follow these steps:
1. Select the "Material lots" group in the navigation area of the APF engineering tool.

All defined attributes of the material lots are displayed in the working area.
2. Click in the row of the attribute to be edited and make the required changes.
3. Click the "Save" button to save the changes.
4. Click the "Dismiss" button to discard the changes.

Deleting attributes
To delete an attribute, follow these steps:
1. Select the row of the attribute to be deleted.
2. Select the "Delete row" command in the "Edit" menu.
The attribute is removed from the working area. 

5.7 Material lot status texts
With the help of the APF engineering tool, you can define various states for the material lots. The 
status texts are displayed in a selection list in the process picture.
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Creating status texts
To define a status text, follow these steps:
1. Select the "Material lot status texts" group in the navigation area of the APF engineering tool.

All defined status texts are displayed in the working area.

2. Click on the last row in the working area and specify the following properties:

Column Explanation
Name Status text
TXTLIB ID for multilingual management in the text library (non-editable; as‐

signed automatically)

3. Click the "Save" button.

Editing status texts
To edit a status text, follow these steps:
1. Select the "Material lot status texts" group in the navigation area of the APF engineering tool.

All defined status texts are displayed in the working area.
2. Click in the row of the status text to be edited and make the required changes.
3. Click the "Save" button to save the changes.
4. Click the "Dismiss" button to discard the changes.

Deleting status texts
To delete a status, follow these steps:
1. Select the row of the status text to be deleted.
2. Select the "Delete row" command in the "Edit" menu.
The status text is removed. 
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5.8 Generating AS function blocks
Following configuration of the material classes and material lots, you can generate function 
blocks using the "Generate blocks" button of the APF engineering tool.

Material classes
A function block of type "FB_XXXMA" is generated for each created material class and stored in 
the master data library.
For information on the "FB_XXXMA" block and its parameter assignment, refer to the description 
of the "FB_XXXMA" function block.

Material lots
A function block of type "FB_MLOT" is generated for the material lot management and stored in 
the master data library.
For information on the "FB_MLOT" function block and its parameter assignment, refer to the 
description of the "FB_MLOT" function block.
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Storage location management 6
6.1 Overview

The "Storage management" APF module is used to implement automation tasks such as the 
following:
• Coordination of the storage locations 
• Comparison of target and actual values of the storage locations
• Posting and clearing materials and material lots (including partial quantities)
• Inventory
• Fast finding of storage locations based on various selection criteria

User archives
You can find information on the storage location management user archives in the "Storage 
management" tab of the "Settings" dialog.

Process pictures
During process control, you use the following picture objects (process pictures and faceplates) 
to perform operator control and monitoring of the data configured using the APF engineering 
tool:

Picture objects Explanation
FB_STOR.PDL Overview picture of all storage locations
FB_STOR_ED.PDL Picture for operator control and monitoring of the stor‐

age location parameters
@FB_STOR_ED_WINDOW.PDL Faceplate for operator control and monitoring of the at‐

tribute and actual value parameters of the storage loca‐
tions

@PG_FB_MAT_ADJ.PDL Faceplate for manual correction posting of material lots 
in the storage locations

@PG_FB_MAT_IN.PDL Faceplate for manual posting of materials / material lots 
to the storage locations

@PG_FB_MAT_OUT.PDL Faceplate for manual clearing of materials / material lots 
from the storage locations

@PG_FB_MAT_IO.PDL Faceplate for manually posting and clearing materials / 
material lots from one storage location to another

@PG_FB_MAT_CONV.PDL Faceplate for converting materials / material lots in a 
storage location 

@PG_FB_ST_SEARCH.PDL Faceplate for searching storage locations based on vari‐
ous selection criteria

@PG_FB_MAT_SEARCH.PDL Faceplate for searching materials / material lots in the 
storage locations based on various selection criteria
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Picture objects Explanation
@FB_Account.PDL Faceplate for two-step posting of materials / material 

lots in the storage locations
@FB_ShowMatLots.PDL Faceplate for displaying material lots during the material 

search
@FB_32BitsRel.PDL Faceplate for displaying procedural releases in the 

"FB_STOR.PDL" picture
@PG_FB_STLOC.PDL Faceplate for searching and selecting storage locations 

based on various selection criteria
@PG_FB_STMAT.PDL Faceplate for searching and selecting materials and ma‐

terial lots based on various selection criteria

Note
You can find information on the transfer of APF pictures to the PH in the section "Transferring APF 
process pictures to the plant hierarchy (Page 104)".

AS function blocks
To generate the function blocks for the storage location management, the APF engineering tool 
uses the "FB_STOR" function block (FB1781) as a template. Based on this template, the APF 
engineering tool generates the following function blocks: 

Function block (FB) Number Function
FB_STORI Specified by the "FB Number 

(I)" field of the APF engineer‐
ing tool

Provides the storage location parame‐
ters (attributes) in the "FB_STORATTR" 
user archive in the AS and transfers the 
actual values in the AS to the "FB_STOR‐
VALUE" user archive
Format of format-related numerical val‐
ues: INTEGER (32)

FB_STORR Specified by the "FB Number 
(R)" field of the APF engineer‐
ing tool

Provides the storage location parame‐
ters (attributes) in the "FB_STORATTR" 
user archive in the AS and transfers the 
actual values in the AS to the "FB_STOR‐
VALUE" user archive
Format of format-related numerical val‐
ues: REAL

For the storage location management, the following functions blocks can also be configured:

Function block (FB) Number Function
FB_STLOC FB1779 Performs search of storage locations for a mate‐

rial from the AS
FB_STMAT FB1780 Performs search of materials in storage loca‐

tions from the AS

Storage location management
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Function block (FB) Number Function
FT_ST_AC FB1782 Performs posting and clearing processes of ma‐

terials / material lots from the AS
FB_SACT FB1783 Performs fast update of up to ten actual values 

for up to 25 "FB_STOR" blocks
The "FB_SACT" function block is adapted to the 
"FB_STOR.pdl" overview picture and can update 
all 25 storage locations displayed in the picture, 
along with their parameters, to the current AS 
status in a single update operation.

Note
For information on the function blocks and their parameter assignment, refer to the 
corresponding block descriptions.

6.2 Storage location groups
With the help of the APF engineering tool, you can define up to 30 storage location groups. The 
storage location groups are saved in the "FB_STORGROUP" user archive.
The storage location groups are displayed in a selection list in the process picture.

Creating storage location groups
To create a storage location group, follow these steps:
1. Open the storage location management in the navigation area of the APF engineering tool.
2. Select the "Storage location groups" group.

All defined storage location groups are displayed in the working area.
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3. Enter the numbers of the function blocks to be generated in the "FB Number (R)" and "FB 
Number (I)" fields. 

Note
Block numbers FB1775-1795 are reserved for APF blocks and must not be overwritten.

4. Click in the empty row of the table in the working area and specify the following properties:

Column Explanation
Name Name of the storage location group
TXTLIB ID for multilingual management in the text library (non-editable; as‐

signed automatically)
Description Description of the storage location group
LIC Location identifier of the storage location group

5. Click the "Save" button.
The storage location group is created.

Editing storage location groups
To edit the properties of a storage location group, follow these steps:
1. Select the "Storage location groups" group in the navigation area of the APF engineering tool.

All defined storage location groups are displayed in a table in the working area.
2. Click in the row of the storage location group to be edited and make the required changes.
3. Click the "Save" button to save the changes.
4. Click the "Dismiss" button to discard the changes.
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Deleting storage location groups
To delete a storage location group, follow these steps:
1. Select the "Storage location groups" group in the navigation area of the APF engineering tool.
2. Select the row of the storage location group to be deleted in the working area.
3. Select the "Delete row" command in the "Edit" menu.
The storage location group is removed. 

6.3 Storage locations
You create and edit the storage locations in Runtime using the "FB_STOR_ED.PDL" process 
picture. Each storage location is assigned to a storage location group. The created storage 
locations are stored in the "FB_STORAGE" user archive.

6.4 Storage attributes
With the help of the APF engineering tool, you can define up to 50 storage attributes. An output 
is created for each attribute when the function blocks are generated for the storage 
management. The attribute data are saved in the "FB_STORATTRIB" user archive.
The storage location attributes are displayed and can be assigned with values for each selected 
storage location in the process picture.
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Creating attributes
To create an attribute, follow these steps:
1. Select the "Storage attributes" group in the navigation area of the APF engineering tool.
2. Specify the number of material lots permitted per storage location.

If this setting is subsequently modified, the corresponding function blocks must be created 
again.
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3. Click on the last row in the working area and specify the following properties:

Column Explanation
Pos Position in the visualization order
Name Name of the attribute
UoM Unit of the attribute
Format Format of the attribute
Enum_Mat Name/coding of an enumeration

The "ENUM_MAT" field can only be selected if you have set "ENUMER‐
ATION" or "Material" as the format of the attribute. You can create 
enumerations in SIMATIC Manager under "Global Declarations".

Low limit Lower operator control limit for numerical values
High limit Upper operator control limit for numerical values
TXTLIB ID for multilingual management in the text library (non-editable; as‐

signed automatically)
FCT_IO_BLOCK_NAME Name of the output in the AS function block
Visible You can use the "Visible" check box to specify whether the attribute is 

displayed in the process picture.
Overview Position of column in the "FB_STOR" overview picture
Width Width of column in the “FB_STOR” overview picture in pixels

4. Click the "Save" button.

Editing attributes
To edit the attributes, follow these steps:
1. Select the "Storage attributes" group in the navigation area of the APF engineering tool.

All defined attributes are displayed in the working area.
2. Click in the row of the attribute to be edited and make the required changes.
3. Click the "Save" button to save the changes.
4. Click the "Dismiss" button to discard the changes.

Deleting attributes
To delete an attribute, follow these steps:
1. Select the row of the attribute to be deleted.
2. Select the "Delete row" command in the "Edit" menu.
The attribute is removed. 

6.5 Storage values
With the help of the APF engineering tool, you can define up to 50 storage values. An input is 
created for each actual value when the function blocks are generated for the storage 
management. The actual values are saved in the "FB_STORVALUE" user archive.
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The actual values are called and displayed in the process picture, depending on the selected 
storage location.
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Creating actual values
To define an actual value, follow these steps:
1. Select the "Storage values" group in the navigation area of the APF engineering tool.

All defined values are displayed in the working area..

2. Click on the last row in the working area and specify the following properties:

Column Explanation
Pos Position in the visualization order
Name Name of the actual value
UoM Unit of the actual value
Format Format of the actual value
Enum_Mat Name/coding of an enumeration

The "ENUM_MAT" field can only be selected if you have set "ENUMER‐
ATION" or "Material" as the format of the attribute. You can create 
enumerations in SIMATIC Manager under "Global Declarations".

TXTLIB ID for multilingual management in the text library (non-editable; as‐
signed automatically)

FCT_BLOCK_IO_NAME Name of the input in the AS function block
Visible You can use the "Visible" check box to specify whether the value is 

displayed in the process picture.
Overview Position of column in the "FB_STOR" overview picture

3. Click the "Save" button.

Editing actual values
To edit defined actual values, follow these steps:
1. Select the "Storage values" group in the navigation area of the APF engineering tool.

All defined values are displayed in the working area..
2. Click in the row of the value to be edited and make the required changes.
3. Click the "Save" button to save the changes.
4. Click the "Dismiss" button to discard the changes.
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Deleting actual values
To delete an actual value, follow these steps:
1. Select the row of the value to be deleted.
2. Select the "Delete row" command in the "Edit" menu.
3. The value is removed from the working area. 

6.6 Storage location status texts
With the help of the APF engineering tool, you can define various status texts for the storage 
locations. The status texts are displayed in the process picture and used for the storage location 
and material searches.
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Creating status texts
To define status texts for the storage locations, follow these steps:
1. Select the "Storage location status texts" group in the navigation area of the APF engineering 

tool.
All defined status texts are displayed in the working area.

2. Click on the last row in the working area and specify the following properties:

Column Explanation
Name Status text
TXTLIB ID for multilingual management in the text library (non-editable; as‐

signed automatically)

3. Click the "Save" button.

Editing status texts
To edit a status, follow these steps:
1. Select the "Storage location status texts" group in the navigation area of the APF engineering 

tool.
All defined status texts are displayed in the working area.

2. Click in the row of the status to be edited and make the required changes.
3. Click the "Save" button to save the changes.
4. Click the "Dismiss" button to discard the changes.
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Deleting status texts
To delete a status, follow these steps:
1. Select the row of the status text to be deleted.
2. Select the "Delete row" command in the "Edit" menu.
The status text is removed. 

6.7 Storage procedural releases
With the help of the APF engineering tool, you can define up to 128 procedural releases. These 
are saved in the "FB_PROCEDURES" user archive.
The representation of the release fields in the process picture corresponds to a 32-bit integer 
value:

Each release occupies one single bit in the 32-bit integer value.
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Creating procedural releases
To define a procedural release, follow these steps:
1. Select the "Storage procedural releases" group in the navigation area of the APF engineering 

tool.
All defined procedural releases are displayed in the working area.

2. Click on the last row in the working area and specify the following properties:

Column Explanation
Name Name of the procedural release
TXTLIB ID for multilingual management in the text library (non-editable; as‐

signed automatically)

3. Click the "Save" button.

Editing procedural releases
To edit a procedural release, follow these steps:
1. Select the "Storage procedural releases" group in the navigation area of the APF engineering 

tool.
All defined procedural releases are displayed in the working area.

2. Click in the row of the procedural release to be edited and make the required changes.
3. Click the "Save" button to save the changes.
4. Click the "Dismiss" button to discard the changes.
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Deleting procedural releases
To delete a procedural release, follow these steps:
1. Select the row of the procedural release to be deleted in the working area.
2. Select the "Delete row" command in the "Edit" menu.
The procedural release is removed. 

6.8 Storage trigger
You can configure triggers for data backup operations. These start the backup of user archive 
data at defined intervals. 
The following triggers are used for backing up the configuration data of the storage 
management.

Trigger Function
FB_STBackupTriggerEN.pas Triggers backup of the configured storage location 

data.
FB_PROCEDURES_BackupTriggerEN.pas Triggers backup of the configured procedural relea‐

ses.
FB_ST_STATUS_BackupTriggerEN.pas Triggers backup of the status texts.

The "FB_STBackupTriggerRT.pas" trigger is used for backing up the runtime data of the storage 
management.
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Configuring a trigger
To configure a trigger with the APF engineering tool, follow these steps:
1. Select the "Storage trigger" group in the navigation area of the APF engineering tool.

The storage triggers are displayed in the working area.

2. Click the "Edit" button in the row of the required trigger.
The "Edit trigger" dialog opens.

3. Configure the following properties of the trigger:

Area/check box Explanation
Name Name of the trigger (non-editable)
Cycle Intervals for executing the actions in runtime:

Standard cycle
Hourly
Daily
Weekly
Monthly
Annually

Enabled Activation of the trigger
Cycle time Timing for executing the trigger (depending on the cycle setting) 
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4. Click "OK".
5. The "Edit trigger" dialog closes.
6. Click the "Save" button in the working area of the APF engineering tool to apply the changes.
7. Click the "Dismiss" button in the working area of the APF engineering tool to discard the 

changes.

6.9 Generating an AS function block
Following configuration of the storage management, you can generate the "FB_STORI" and 
"FB_STORR" function blocks using the "Generate FBs" button of the APF engineering tool.

6.10 FB_SACT function block restrictions
This block is used for updating the storage location overview screen "FB_STOR.pdl". The 
maximum volume of data that can be sent using raw data via the BSEND function block may be 
reached with this block (16230 bytes). You must therefore make sure that the user-defined 
columns can be displayed on the "FB_STOR.pdl" overview screen. Because 25 rows (storage 
locations) are displayed on the screen, each column needs 25 times the memory space in the AS 
function block "FB_SACT". The following table shows the memory space required for each of the 
various formats that can be shown on the screen. The sum of the memory space required by the 
maximum of ten columns must not exceed 16230 bytes.

Integer value Format Memory requirements
   
0 INTEGER 32 25 * 4 bytes = 100 bytes
   
1 REAL without decimal places 25 * 4 bytes = 100 bytes
2 REAL with 1 decimal place 25 * 4 bytes = 100 bytes
3 REAL with 2 decimal places 25 * 4 bytes = 100 bytes
4 REAL with 3 decimal places 25 * 4 bytes = 100 bytes
5 REAL with 4 decimal places 25 * 4 bytes = 100 bytes
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Integer value Format Memory requirements
   
10 STRING     8 characters 25 * 10 bytes = 250 bytes
11 STRING   16 characters 25 * 18 bytes = 450 bytes
12 STRING   32 characters 25 * 34 bytes = 850 bytes
13 STRING   64 characters 25 * 66 bytes = 1650 bytes
14 STRING 128 characters 25 * 130 bytes = 3200 bytes
15 STRING  14 characters (for PLM Dairy Li‐

brary)
25 * 16 bytes = 400 bytes

   
20xx DATE 25 * 8 bytes = 200 bytes
21xx TIME 25 * 8 bytes = 200 bytes
22xx DATE AND TIME 25 * 8 bytes = 200 bytes
   
30 BOOL 25 * 2 bytes = 50 bytes
40 ENUMERATION 25 * 4 bytes = 100 bytes
50 MATERIAL 25 * 4 bytes = 100 bytes
51 MATERIAL (release check) X 25 * 4 bytes = 100 bytes
52 MATERIAL LOT (release check) X 25 * 4 bytes = 100 bytes
53 MATERIAL LOT CONTENTS FORMAT X 25 * 4 bytes = 100 bytes
54 CONTENTS FORMAT (format-related value, 

cannot be modified)
25 * 4 bytes = 100 bytes

60 32BITS (material releases) X 25 * 4 bytes = 100 bytes
61 32BITS (material type releases) X 25 * 4 bytes = 100 bytes
70 CONTENTS FORMAT (format-related value, 

can be modified)
25 * 4 bytes = 100 bytes
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Parameter management 7
7.1 Overview

The "Parameter management" APF module is used to implement automation tasks such as the 
following:
• Creating and managing parameter set data and their properties
• Specifying of limits and parameter set releases
• Normalizing/recalculating attribute values of the parameter sets

User archives
You can find information on the user archives of parameter management in the "Parameter 
management" tab of the "Settings" dialog.

Process pictures
During process control, you use the following picture objects (process pictures and faceplates) 
to perform operator control and monitoring of the data configured using the APF engineering 
tool:

Picture objects Explanation
FB_PARAM_ED.PDL Picture for operator control and monitoring of the 

parameter set data
@FB_PARAM_ED_WINDOW.PDL Faceplate for operator control and monitoring of 

the attributes of the parameter sets
@PG_FB_000PA.PDL
@PG_FB_000PA_OVERVIEW.PDL
@PG_FB_000PA_STANDARD.PDL
@PG_FB_000PA_VIEWLIST.PDL

Faceplate for displaying a parameter set loaded in 
the block

@FB_PARAM_WINDOW.PDL Faceplate for operator control and monitoring of 
attribute limits of a parameter set loaded in the 
block.

FB_PARAM_ED_LIMITS.PDL Picture for operator control and monitoring of the 
parameter assignment of the limits of a parameter 
group

@FB_PARAM_ED_LIMITS_WINDOW.PDL Faceplate for operator control and monitoring of 
the attribute limits of a parameter set

Note
You can find information on the transfer of APF pictures to the PH in the section "Transferring APF 
process pictures to the plant hierarchy (Page 104)".
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AS function blocks
To generate the function blocks for the parameter management, the APF engineering tool uses 
the "FB_XXXPA" function block (FB1784) as a template. The functions of this function block 
include the following:
• Provision of the parameter set data in the user archive via the User Archive Read Manager in 

the AS
• Normalization of the parameter set data
• Transfer of the parameter set data in the AS to the user archive via the User Archive Write 

Manager

7.2 Parameter groups 
With the help of the APF engineering tool, you can define parameter groups. A function block of 
type "FB_XXXPA" is generated for each parameter group. The parameter groups are saved in the 
"FB_PARAMGROUP" user archive.
The parameter groups are displayed in a selection list in the process picture.

7.2.1 Creating and editing parameter groups

Creating parameter groups
To create a parameter group, follow these steps:
1. Open the parameter management in the navigation area of the APF engineering tool.
2. Select the "Parameter groups" group.
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3. Select the "New" command in the shortcut menu.
The "Add Parameter group" dialog opens.

4. Enter a name for the parameter group and click the "OK" button.
The parameter group is created with default properties and displayed in the navigation area. 

Editing a parameter group
In the working area of the APF engineering tool, you can edit the following properties of the 
parameter groups:

Area Explanation
Name Name of the parameter group
Description Description of the parameter group
Textlib ID ID for multilingual management in the text library (non-editable; as‐

signed automatically)
FB number Number of the function block that is generated for the parameter group.

Block numbers FB1775-1795 are reserved for APF blocks and must not 
be overwritten.

To edit the properties of a parameter group, follow these steps:
1. Select the required parameter group in the navigation area.

The properties of the selected parameter group are displayed in the working area.
2. Define the properties of the required parameter group.
3. Click the "Save" button to save the changes.
4. Click the "Dismiss" button to discard the changes.

Deleting a parameter group
Deletion is not possible, in order to guarantee data consistency.
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7.2.2 Creating and editing attributes
You can define up to 100 attributes for each parameter group. An output is created for each 
attribute when the corresponding function block is generated. The attribute data are saved in 
the "FB_PARAMATTRIB_XXX" user archives. 
You can specify and edit the attribute values for each parameter set in the process pictures: 
• FB_PARAM_ED.PDL

Adding new attributes to a parameter group
To add an attribute to a parameter group, follow these steps:
1. Select the required parameter group in the navigation area of the APF engineering tool.

All attributes of the selected parameter group are displayed in the working area.

2. Click on the last row in the working area and specify the following properties:
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Column Explanation
Pos Position in the visualization order
Name Name of the attribute
UoM Unit of the attribute
Format Format of the attribute
Enum_Mat Name/coding of an enumeration

The "ENUM_MAT" field can only be selected if you have set "ENUMER‐
ATION" or "Material" as the format of the attribute. You can create enu‐
merations in SIMATIC Manager under "Global Declarations".

Low limit Lower operator control limit for numerical values
High limit Upper operator control limit for numerical values
TEXTLIB ID for multilingual management in the text library (non-editable; as‐

signed automatically)
FCT_IO_BLOCK_NAME Name of the output in the AS block
Visible You can use the "Visible" check box to specify whether the attribute is 

displayed in the process picture.
Editable You can use the "Editable" check box to specify whether the attribute 

can be edited in the faceplate.
Standard You can use the "Norm" field to specify whether the attribute is nor‐

malized. The field is only editable for attributes with INTEGER or REAL 
format.
You can find more detailed information on normalization in the section 
"Normalization/Recalculation (Page 88)".

1. Click the "Save" button.

Editing attributes
To edit the attributes, follow these steps:
1. Select the required parameter group in the navigation area of the APF engineering tool.

All attributes of the selected parameter group are displayed in the working area.
2. Click in the row of the attribute to be edited and make the required changes.
3. Click the "Save" button to save the changes.
4. Click the "Dismiss" button to discard the changes.

Deleting attributes
To delete an attribute, follow these steps:
1. Select the row of the attribute.
2. Select the "Delete row" command in the "Edit" menu.
The attribute is removed. 
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7.3 Normalization/Recalculation
With the help of the APF engineering tool, you can specify whether normalization/recalculation 
is performed for each attribute of a parameter group. This is specified using the "Norm" value of 
the attributes.

You can enter the following values in the "Norm" field:
• "Standard" = 0: No normalization/recalculation
• "Norm" = 1: Normalization/recalculation is performed according to the equations of the 

following functions: 
– FB_CalcValueByNormPM.fct
– FB_ReCalcValueByNormPM.fct

Linear normalization of the values is performed in the template.
You specify the parameter set values that are normalized and recalculated,as well as the 
standard charge quantity via the process picture: 

If you set the standard charge quantity to "0", the normalization/recalculation is not 
performed. 

• "Norm" > 1: The normalization/recalculation is performed according to user-defined 
equations. The "FB_CalcValueByNormPM.fct" and "FB_ReCalcValueByNormPM.fct" functions 
must be extended appropriately for this.

The equations for "Norm" = 0 / 1 must not be changed.
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7.4 Parameter sets
You create the parameter sets in Runtime using the "FB_PARAM_ED.PDL" process picture. Each 
parameter set is assigned to a parameter group and is defined by the values that are specified for 
the individual attributes of the parameter group. The created parameter sets are stored in the 
"FB_PARAM_XXX" user archives.

7.5 Parameter trigger
You can configure triggers for data backup operations. These start the backup of user archive 
data at defined intervals. 
The following triggers are used for backing up the data of the parameter management.

Trigger Function
FB_PMBackupTriggerEN.pas Triggers backup of the configured parameter data.
FB_PMBackupTriggerRTx.pas Triggers a backup of the runtime data.

For each parameter group, a trigger is created au‐
tomatically and numbered consecutively.

Parameter management
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Configuring a trigger
To configure a trigger with the APF engineering tool, follow these steps:
1. Select the "Parameter trigger" group in the navigation area of the APF engineering tool.

The parameter triggers are displayed in the working area.

2. Click the "Edit" button in the row of the required trigger.
The "Edit trigger" dialog opens.

3. Configure the trigger using the following settings:

Area/check box Explanation
Name Name of the trigger (non-editable)
Cycle Intervals for executing the actions in runtime:

Standard cycle
Hourly
Daily
Weekly
Monthly
Annually

Enabled Activation of the trigger
Cycle time Timing for executing the actions

(depending on the cycle setting)
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4. Click "OK".
5. The "Edit trigger" dialog closes.
6. Click the "Save" button in the working area of the APF engineering tool to apply the changes.
7. Click the "Dismiss" button in the working area of the APF engineering tool to discard the 

changes.

7.6 Generating AS function blocks
Following configuration of the parameter groups and their attributes, you can generate the 
corresponding function blocks using the "Generate FBs" button of the APF engineering tool.

A function block of type "FB_XXXPA" is generated for each created parameter group and stored 
in the master data library.
For information on the "FB_XXXPA" block and its parameter assignment, refer to the description 
of the "FB_XXXPA" function block.
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Archive management 8
8.1 Overview

The "Archive management" APF module is used to implement automation tasks such as the 
following:
• Creating and updating of archiving data records
• One-time export and configurable deletion of archive data records for external post-

processing

User archives
You can find information on the archive management user archives in the "Archive 
management" tab of the "Settings" dialog.

OS process pictures
The archive management is configured on the AS and controlled on the OS using WinCC scripts. 
No picture objects are needed for this module. Execution of the archive functions is triggered via 
the interconnected APF modules.

AS function blocks
To generate the function blocks for the archive management, the APF engineering tool uses the 
"FB_XXXA" function block (FB1793) as a template and generates the following function blocks 
for each created archive group: 

Function block (FB) Number Function
FB_XXXAI Specified by the "FB Number 

(I)" field of the APF engineer‐
ing tool

Creates, updates, and deletes archive 
data records of format "INTEGER (32)" 
(for format-related numerical values)

FB_XXXAR Specified by the "FB Number 
(R)" field of the APF engineer‐
ing tool

Creates, updates, and deletes archive 
data records of format "REAL" (for for‐
mat-related numerical values)

8.2 Archive groups
With the help of the APF engineering tool, you can define archive groups with different data 
structures. For each created archive group, the APF engineering tool generates the "FB_XXXAI" 
and "FB_XXXAR" function blocks.
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Creating archive groups
To create an archive group, follow these steps:
1. Open the archive management in the navigation area of the APF engineering tool.
2. Select the "Archive groups" group.
3. Select the "New" command in the shortcut menu.

The "Add Archive group" dialog box opens.

4. Enter a name for the archive group and click the "OK" button.
The archive group is created with default properties and displayed in the navigation area. 

Editing an archive group
In the working area of the APF engineering tool, you can edit the following properties of the 
archive groups:

Field Explanation
Name Name of the archive group
Description Description of the archive group
Textlib ID ID for multilingual management in the text library (non-editable; as‐

signed automatically)
FB number (I) Number of the function block that is generated for the archive data re‐

cords in format "INTEGER (32)".
Block numbers FB1775-1795 are reserved for APF blocks and must not 
be overwritten.

FB number (R) Number of the function block that is generated for the archive data re‐
cords in format "REAL".
Block numbers FB1775-1795 are reserved for APF blocks and must not 
be overwritten.

Reserve The minimum number of data records (free capacity) in the archive be‐
low which the system starts to delete data records.

Archive management
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Field Explanation
No. DS to delete Number of archive data records to be deleted

Example:
• High limit = 10000
• Reserve = 100
• No. DS to delete = 200
At least 200 data records are deleted as soon as the number of data 
records reaches or exceeds 9900. After deletion, there are still 9700 data 
records in the archive.

Type You can create archive groups of the following types:  
Batch related: Predefined batch-related values are assigned automatical‐
ly in the archive group. Editing of these values is restricted. The remain‐
ing values can be freely defined by the user.
Freely definable: All values of the archive group can be freely defined.

Export method You can select one of the following methods for exporting the archive 
data records:
Data export with deleting and MES
Data export with deleting without MES
Data export without deleting with MES
Data export without deleting without MES
Data management as circular archive
Deleting of data with maximum archive size

Export path 1 First path for data export
Export path 2 Second path for data export (optional)

Note
Export = one-time export of selected data records to an external CSV file and deletion of these 
data records using a specified export method
Backup = complete backup of all data records in a user archive in an external CSV file

Archive management
8.2 Archive groups

Advanced Process Functions Engineering Manual
System Manual, 06/2022, A5E38719921-AB 95



To edit the properties of an archive group, follow these steps:
1. Select the required archive group in the navigation area.

The properties of the selected archive group are displayed in the working area.

2. Edit the properties of the archive group.
3. Click the "Save" button to save the changes.
4. Click the "Dismiss" button to discard the changes.

Deleting archive groups
Deletion is not possible, in order to guarantee data consistency.

8.3 Archive values
You can assign up to 100 values to each archive group. For batch-related archiving, 25 default 
values are created automatically. 
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Creating archive values
To create values for an archive group, follow these steps:
1. Select the required archive group in the navigation area of the APF engineering tool.

All defined values of the selected archive group are displayed in the working area.

2. Specify the following properties:

Column Explanation
Pos Position
Name Name of the value
UoM Unit of the value
Format Format of the value
Enum_Mat Name/coding of an enumeration

The "ENUM_MAT" field can only be selected if you have set "ENUMER‐
ATION" or "Material" as the format of the attribute. With "Archive enu‐
meration", you can specify the name. You can create enumerations in 
SIMATIC Manager under "Global Declarations".

Low limit Upper operator control limit for numerical values
High limit Lower operator control limit for numerical values
TXTLIB ID for multilingual management in the text library (non-editable; as‐

signed automatically)
FCT_IO_BLOCK_NAME Name of the input in the AS function block
Visible You can use the "Visible" check box to specify whether the value is 

displayed in the process picture.
Description Description of the value

3. Click the "Save" button.
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Editing archive values
To edit created values, follow these steps:
1. Select the required archive group in the navigation area of the APF engineering tool.

All defined values of the selected archive group are displayed in the working area.
2. Click in the row of the value to be edited and make the required changes.
3. Click the "Save" button to save the changes.
4. Click the "Dismiss" button to discard the changes.

Deleting archive values
To delete a value, follow these steps:
1. Select the row of the value to be deleted.
2. Select the "Delete row" command in the "Edit" menu.
The value is deleted. 

8.4 Archive job status texts
In the "Status texts" group in the navigation area of the APF engineering tool, you can define 
various status texts for the archive jobs.
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Creating status texts
To create a status text, follow these steps:
1. Select the "Status texts" group in the navigation area of the APF engineering tool.

All defined status texts are displayed in the working area.

2. Click on the last row in the working area and specify the following properties:

Column Explanation
Name Status text
TXTLIB ID for multilingual management in the text library (non-editable; assigned 

automatically)

3. Click the "Save" button.

Editing status texts
To edit a status text, follow these steps:
1. Select the "Status texts" group in the navigation area of the APF engineering tool.

All defined status texts are displayed in the working area.
2. Click in the row of the status text to be edited and make the required changes.
3. Click the "Save" button to save the changes.
4. Click the "Dismiss" button to discard the changes.

Deleting status texts
To delete a status text, follow these steps:
1. Select the row of the status text.
2. Select the "Delete row" command in the "Edit" menu.
The status text is removed from the working area. 
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8.5 Archive trigger
You can configure triggers for the export and backup operations. These start the backup of user 
archive data at defined intervals. 
The following triggers are used for backing up the configuration data of the archive 
management.

Trigger Function
FB_ARBackupTriggerEN.pas Triggers backup of the configuration data.
FB_JOB_STATUS_BackupTriggerEN.pas Triggers backup of the job status texts.
FB_DeleteMarkedRecordsTrigger.pas When using MES, triggers the deletion of records 

read.

For each created archive group, the following triggers are automatically created and 
consecutively numbered:

Trigger Function
FB_ARBackupTriggerRTX.pas Triggers backup of the runtime data.
FB_ARExportTriggerX.pas Triggers export of the data according to the speci‐

fied method.

Archive management
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Configuring a trigger
To configure a trigger, follow these steps:
1. Select the "Archive trigger" group in the navigation area of the APF engineering tool.

The archive triggers are displayed in the working area.

2. Click the "Edit" button in the row of the required trigger.
The "Edit trigger" dialog opens.

3. Configure the trigger using the following settings:

Area/check box Explanation
Name Name of the trigger (non-editable)
Cycle Intervals for executing the actions in runtime:

Standard cycle
Hourly
Daily
Weekly
Monthly
Annually

Enabled Activation of the trigger
Cycle time Timing for executing the actions (depending on the cycle setting)
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4. Click "OK".
5. The "Edit trigger" dialog closes.
6. Click the "Save" button in the working area of the APF engineering tool to apply the changes.
7. Click the "Dismiss" button in the working area of the APF engineering tool to discard the 

changes.

8.6 Generating AS function blocks
Following configuration of the archive groups and their values, you can generate the associated 
function blocks using the "Generate FBs" button of the APF engineering tool.

Archive management
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Additional steps for configuring 9
9.1 Running the APF Integrator

Following configuration with the APF engineering tool, the APF Integrator must be run in all OS 
projects to transfer the configured data to the entire project level.

Note
The file FB_Configuration.ini is transferred automatically from the Engineering Tool. Thus it is 
not imperative that the APF Integrator is run in the case of changes that do not exclusively 
affect the .ini file.
Exception: On first creating a material class, parameter group, or archive group, the Integrator 
must be run because only then will the relevant images be copied into the project.

Requirement
• WinCC Explorer is open.

Procedure
To run the APF Integrator, follow these steps:
1. Select the "APF engineering tools" object in the navigation area of WinCC Explorer.
2. Select the "Integrator" command in the shortcut menu.

The "Server - Integrator" dialog opens.
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3. Click the "Integrate" button.
4. Close the "Server - Integrator" dialog after the APF Integrator has been run successfully.

Note
If the "Overwrite user-specific functions" check box is selected, the following functions are 
overwritten in the FB_UA_USER_SPECIFIC subfolder:
• FB_ReCalcValueByNormPM.fct
• FB_GetFilterAndSortValues.fct
• FB_ConvertUOM.fct
• FB_CalcValueByNormPM.fct

9.2 Transferring APF process pictures to the plant hierarchy
Preconfigured WinCC objects (process pictures and faceplates) are available for operator control 
and monitoring of the APF modules on the OS. To assign the process pictures to the 
corresponding hierarchy folders of the PH, these folders must be imported into the component 
view of SIMATIC Manager.
The picture objects for the individual APF modules can only be transferred once the modules 
have been configured with the APF engineering tool.

Requirement 
• The component view of SIMATIC Manager is open.

Procedure
To assign the APF process pictures to the plant hierarchy, follow these steps:
1. Select the OS in the component view of your multiproject.
2. Select the "Import WinCC objects" command in the shortcut menu.

The process pictures are imported and displayed in the component view.
3. Select the process pictures and move them from the component view into the required 

hierarchy folder of the PH using a drag-and-drop operation while simultaneously pressing 
the <Shift> key.
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Note
The process pictures may be available in different versions. For example, the material lot editor 
(.pdl picture) available by default as FB_MAT_LOT_ED (recommended for resolution 
1280x1024), is also additionally available as FB_MAT_LOT_ED-1920 optimized for 1920x1080 
resolution and an improved form. Please use the pictures that best match the resolution selected 
in the "WinCC Explorer OS Project Editor".
An advantage of the new material editor in high resolution (FB_MAT_ED-1920) is the built-in 
function for convenient material search.

9.3 Automatically transferring changes of user archives

Objective
Changes to groups, classes, parameters, and attributes made with the engineering tool usually 
produce new or modified tables, table columns, and contents in user archives. This initially only 
happens on the engineering station (ES). To avoid the manual export and import of user archives 
and archive contents, APF has a function for automatic transfer to the OS.

Handling changes
The engineering tool detects changes that affect the user archives. It then automatically exports 
the metadata archives to the <Project directory>\Library\APF\Metadata folder when function 
blocks are saved or generated.
When the OS is loaded, the metadata are automatically transferred and entered in the 
FB_MetaDataReloaded user archive for monitoring.   

Applying changes
On the OS, the APFEngineeringDataLoader.exe program searches for new metadata files and 
integrates them into the existing user archives after a backup. The engineering tool enters the 
APFEngineeringDataLoader.exe program in the OS startup list.

Note
Following changes to the user archives, manual adjustments may be required before you can re-
load older data backed up using mechanisms such as the "…BackupTrigger…" from user archives.
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Deleting data in the case of changes
Changes made through the engineering tool may lead to structural changes in tables. Data that 
already exist in the affected tables are therefore deleted from the engineering tool. This will 
occur in the case of the following, amongst others:
•  New attribute (new column in the user archive)
• Change in data type (e.g. REAL to STRING)
• Delete attribute (column in user archive is deleted)
Data will not be deleted in the case of the following, amongst others:
• Change in field size (e.g. STRING 8 to STRING 16)
• Change in attribute name

9.4 Change to the archive structure, manual data transfer

9.4.1 General information
The automatic metadata synchronization described above does not always result in obtaining 
the available runtime data. The engineering tool generates a corresponding warning in these 
cases. 
In some cases, changes to existing user archives may affect the structure of the corresponding 
runtime archive, the content of the corresponding configuration archive and the interface of the 
relevant AS function block. Changes which may have this effect include adding parameters / 
attributes. No automatic process is currently available to deal with this. The following steps must 
therefore be performed manually.

Note
To avoid this type of change, it is advisable to create a number of invisible reserve parameters / 
attributes in advance which can then be made visible and used where necessary. This avoids the 
need for a complete AS download and prevents a structure change in the runtime archive.

The examples below are based on a parameter being added to parameter set group 1. Archives 
FB_PARAM_001 and FB_PARAMATTRIB_001 are affected accordingly. The following table shows 
the relationships for all other archives:

Module Runtime archives (struc‐
ture change)

Configuration archive (con‐
tent change)

AS blocks (interface 
change)

Material manage‐
ment

FB_MATERIAL_xxx FB_MATATTRIB_xxx FB_xxxMA

Material lot man‐
agement

FB_MATERIAL_LOT FB_MATATTRIB_LOT FB_MLOT

Storage location 
management

FB_STORAGE FB_STORATTRIB / FB_STOR‐
VALUE

FB_STORI / FB_STORR

Additional steps for configuring
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Module Runtime archives (struc‐
ture change)

Configuration archive (con‐
tent change)

AS blocks (interface 
change)

Parameter man‐
agement

FB_PARAM_xxx FB_PARAMATTRIB_xxx FB_xxxPA

Archive manage‐
ment

FB_ARCHIVING_xxx FB_ARCHVALUE_xxx FB_xxxAI / FB_xxxAR

xxx represents the respective material class / parameter set group / archiving group to which 
changes are being made. In the special case of storage location management, the configuration 
archive for attribute changes is FB_STORATTRIB and the configuration archive for value changes 
FB_STORVALUE.
To perform such a change without loss of process data, the following procedure should be 
followed. A distinction is made between a single-user station and server/client architecture.

9.4.2 Single-user station

Requirements
• No read or write access is being performed to the archive to be changed.
• No changes have yet been made

Note
We recommend that you do not perform this procedure in runtime. Changes cannot be 
downloaded in runtime because an interface change is required at the AS function block. If 
runtime is not active, you can also be sure that there is no read or write access to the archive to 
be changed.

Procedure
1. Creating a backup of the multiproject
2. Export and save the content of the runtime archive FB_PARAM_001 using the user archive 

editor (menu, "Runtime data" -> "Export")
3. Implement change in the engineering tool.

Note
The function block must be recompiled after a parameter is added. This results in a structure 
change at runtime archive FB_PARAM_001 and the loss of the content. The content of the 
configuration archive FB_PARAMATTRIB_001 is also changed, as is the interface of the 
FB_001PA function block. You therefore need to perform a complete download of the AS.

4. Run the APF Integrator in all OS projects
5. Adapt the exported content from step 2 to the new archive structure (a new column has been 

added and this column has now also to be added to the CSV file). This can be done using MS 
Excel or a similar program.
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6. Import the adapted CSV file to the runtime archive FB_PARAM_001 using the user archive 
editor (menu, "Runtime data" -> "Import")

7. Replace the modified AS function block FB_001PA in the multiproject
8. Compile and download AS
9. Compile the OS server project

9.4.3 Multi-user system (server / client)

Requirements
• No read or write access is being performed to the archive to be changed.
• No changes have yet been made

Note
We recommend that you do not perform this procedure in runtime. Changes cannot be 
downloaded in runtime because an interface change is required at the AS function block. If 
runtime is not active, you can also be sure that there is no read or write access to the archive to 
be changed.

Procedure
1. Creating a backup of the multiproject
2. Export and save the content of the runtime archive FB_PARAM_001 using the user archive 

editor (menu, "Runtime data" -> "Export")
3. Implement change in the engineering tool.

Note
The function block must be recompiled after a parameter is added. This results in a structure 
change at runtime archive FB_PARAM_001. The content of the configuration archive 
FB_PARAMATTRIB_001 is also changed, as is the interface of the FB_001PA function block. 
You therefore need to perform a complete download of the AS.

4. Run the APF Integrator in all OS projects
5. Export and save the modified content of the configuration archive FB_PARAMATTRIB_001 on 

the ES using the user archive editor (menu, "Runtime data" -> "Export")
6. Delete the content of the configuration archive FB_PARAMATTRIB_001 on the OS server 

using the user archive editor (activate runtime mode under "Edit" -> "Runtime data", select 
archive FB_PARAMATTRIB_001, and select and delete all rows)

7. Import the CSV file from step 5 to the configuration archive FB_PARAMATTRIB_001 using the 
user archive editor (menu, "Runtime data" -> "Import") on the OS server

Additional steps for configuring
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8. Use the user archive editor to delete the complete FB_PARAM_001 runtime archive from the 
OS server (content saved in step 2).

9. Replace the modified AS function block FB_001PA in the multiproject
10.Compile and download AS
11.Compile the OS server project
12.Download OS server: The runtime archive FB_PARAM_001 deleted in step 7 is created again 

with the new structure in the OS project and on the OS server.
13.Adapt the exported content from step 2 to the new archive structure (a new column has been 

added and this column has now also to be added to the CSV file). This can be done using MS 
Excel or a similar program.

14.Import the adapted CSV file to the runtime archive FB_PARAM_001 using the user archive 
editor (menu, "Runtime data" -> "Import")

Note
Steps 2, 6, 7, 8 and 14 are performed directly on the OS server. All other steps are performed on 
the ES.

9.5 General information on the engineering tool
Following a structural change (for example, adding a new attribute), you should also promptly 
regenerate and use the block after saving. Otherwise, problems may occur due to non-matching 
data structures between block users archive and editor dialog.
Spaces either within or at the end of the IO name (connection name of the attribute at the block) 
are not allowed.
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Diagnostics guide 10
10.1 Troubleshooting procedure

Ini file
One of the greatest sources of errors in the configuration phase is the inconsistent use of the ini 
file (FB_Configuration.ini). This file must be identical on each OS computer in the project. 
Problems can arise if some of the OS project computers are operating with a modified ini file, 
while others are still using an old ini file which has not been adapted to the project. In order to 
prevent this, the engineering tool automatically copies the ini file to the project directory. 
One frequent cause of errors is the ServerPrefix entry in the ini file. It can be adapted using the 
engineering tool. The symbolic computer name of the OS server project must end in "::". If you 
can access the APF user archive in runtime using an APF faceplate on an operable OS server, but 
not on an OS client, the most likely reason is the wrong ServerPrefix entry in the ini file (or the 
wrong ini file on the OS client, in which the ServerPrefix entry is also wrong).

Text library
APF uses the text library of the OS server for multilingual management of configuration data, for 
example, the name of material classes. If the text library is exported during the engineering 
phase to simplify processing (for example, in MS Excel), you must be careful not to trigger OS 
compilation or open any OS project editors between exporting and importing the text library. If 
you do, this can cause problems because the text library might then contain entries in the wrong 
places.

Messages
Runtime errors are output as messages. If messages are not output or the message row is empty, 
check alarm logging to see whether the messages have been imported and are also available in 
the relevant runtime language.

User archive data
You need to distinguish between runtime data and configuration data in the user archive. In the 
engineering phase, a number of different archives are created and content generated using the 
engineering tool. This content and the archive structure are referred to as "configuration data" 
as they are generated on the ES during the engineering phase. If a data record (material, 
parameter set, etc.) is then created on an OS client or OS server during project runtime, this data 
record will only be available on the OS server (pair). This content can be referred to as "runtime 
data" because it is created in OS runtime.
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This means there are two types of archives. They are listed in the table below:

Archive name Type Explanation
FB_MATCLASS Configuration List of all material classes
FB_MATTYPE_xxx Configuration List of material types of material class xxx
FB_MATATTRIB_xxx Configuration Structure of material class xxx
FB_MATERIAL_xxx Runtime Storage location for materials of material 

class xxx
FB_MATATTRIB_LOT Configuration Structure of the material lot table
FB_MATERIAL_LOT Runtime Storage location for material lots
FB_STORGROUP Configuration List of all storage location groups
FB_STORATTRIB Configuration Structure of the storage attributes
FB_STORVALUE Configuration Structure of the storage values
FB_STORAGE Runtime Storage for storage locations
FB_PARAMGROUP Configuration List of all parameter set groups
FB_PARAMATTRRIB_xxx Configuration Structure of parameter set group xxx
FB_PARAM_xxx Runtime Storage location for parameter sets of the 

parameter set group xxx
FB_PARAM_CALC_xxx Runtime Storage location for recalculations of pa‐

rameter sets of parameter set group xxx
FB_ARCHGROUP Configuration List of all archiving groups
FB_ARCHVALUE_xxx Configuration Structure of archiving group xxx
FB_ARCHIVING_xxx Runtime Storage location for archiving data records 

of archiving group xxx
FB_PROCEDURES Configuration Storage location for procedures
FB_STOR_ST_STATUS Configuration Storage location for storage location status
FB_STOR_MAT_STATUS Configuration Storage location for material status

To summarize:
• Runtime archives are written during runtime.
• Configuration archives are written during the engineering phase on the ES.
To avoid the loss of runtime archives, their content is not copied with server downloads. Archive 
content is only copied the first time a server is downloaded (no existing OS folder in the target 
location). This may mean that subsequent changes to archives during the engineering phase are 
not applied to the server upon download.
Remedy:
1. If existing runtime databases can be overwritten in the engineering phase and no APF 

runtime archives have yet been filled: Delete target folder and download entire server / 
servers.

2. Export user archive content on the ES and import content on the server.

Diagnostics guide
10.1 Troubleshooting procedure

Advanced Process Functions Engineering Manual
112 System Manual, 06/2022, A5E38719921-AB



User archive structure
The structure (number and format of columns) of a runtime archive consists of a fixed columns 
component (e.g., name and ID) and a variable component. The variable column component 
depends on the configuration with the relevant engineering tool. For every attribute / parameter 
generated, a column in the correct format (integer, string, etc.) is created in the runtime archive 
and a row in the corresponding configuration archive (FB_yyyATTRIB_xxx or FB_yyyVALUE_xxx). 
For example, the runtime archive FB_MATERIAL_001, which contains materials of materials class 
1, is firmly assigned to configuration archive FB_MATATTRIB_001, which saves more detailed 
information (row by row) on the corresponding column in the runtime archive.
This detailed information is used during runtime by the APF OS pictures and during AS / OS 
communication with FB_UA_RM or FB_UA_WM.
The AS function block is also created using the configuration archive.
If these two archives do not match, problems may occur during runtime. We therefore strongly 
advise you not to manipulate attributes manually. Attributes should only be modified using the 
corresponding engineering tool, which correctly adapts both of the archives affected.
Typical error messages / errors in this procedure are as follows:
• Length errors reading a data record from the AS function block indicate that the structure of 

the runtime archive does not correspond to the AS function block or does not correspond to 
the configuration archive.

• When data appear in the wrong position on the runtime screen or are saved at the wrong 
position in the runtime archive, this is also an indication that the runtime archive, block and 
corresponding configuration archive are not consistent.

10.2 Useful information on error diagnostics

AS function blocks
All APF AS function blocks have error outputs for precise diagnostics. Many blocks also have an 
output that provides error codes for more detailed analysis. You can find more detailed 
information in the block descriptions or the online help for the relevant AS function block.

Log files
Various log files are available to help you diagnose problems using APF.
Engineering tool
The engineering tool log files can be accessed at <Program Files path>\SIEMENS\WINCC
\diagnose\APF_Engineering_##.txt.

Integrator
The APF Integrator log file can be accessed at <Program Files Path>\SIEMENS\WINCC\diagnose
\logfile_integrator.txt
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Runtime data
There are two versions of log files for runtime processes. Both files are located in the standard 
WinCC diagnostics directory (<WinCC installation directory>\Diagnostics) on each computer.
• APF_OS_Diag.log: This log file contains all errors which have occurred during write or read 

access to the user archive and which only affect the OS. This file is stored on each OS 
computer (OS client and OS server). 

• APF_OS_AS_Diag.log: This log file contains all errors which have occurred during AS / OS 
communication with FB_UA_RM or FB_UA_WM. This log file is therefore only available on the 
OS server (or on both OS servers of a redundant OS server pair).

The log files differ from computer to computer and are not synchronized. This enables more 
exact error diagnostics and also helps to establish the computer on which the error was caused.
Downloading the OS project to the computer does not overwrite the log files. They therefore 
remain on the relevant computers for the duration of a project.

Outputs in the C console
The OS section of the APF is based on C functions that provide useful information for diagnostics 
in the C output window (apdiag). But because this type of troubleshooting is extremely complex, 
you should only use it if you are unable to find the source of the error by other means.

Activating / deactivating diagnostic messages
You can enable and disable a number of different diagnostic levels on the APF_Debug.pdl 
diagnostic screen:
• bDebugModul01: Enables/disables outputs in the C console
• bDebugModul02: Enables/disables diagnostics in the APF_OS_AS_Diag.log logfile
• bDebugModul03: Enables/disables diagnostics in the APF_OS_Diag.log logfile
• bDebugModul04: Enables/disables diagnostics via OS process control messages with error 

codes
• bDebugModul05: Not used
• bDebugModul06: Not used
• bDebugModul07: Not used
• bDebugModul08: Not used
• bDebugModul09: Not used
• bDebugModul10: Not used
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